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1.1.0 Introduzione 

1.1.1 Glossario
Di seguito è riportato un elenco di termini importanti utilizzati all'interno del 
documento.

MIS - Management Information Systems. La parte operativa di un flusso di lavoro 
JDF che presiede a tutti i processi e tutte le comunicazioni tra i componenti e il 
controllo di sistema.

Dispositivo - Il componente di una parte del flusso di lavoro JDF che interpreta 
JDF ed esegue le istruzioni

Controller - Il componente di un flusso di lavoro basato su JDF che avvia i 
dispositivi, indirizza JDF e comunica informazioni sullo stato

Canale persistente - Una connessione dedicata che abilita il Servizio JMF a 
inviare segnali JMF al MIS

Job Description Format (JDF) - Formato dati basato su XML che descrive un 
lavoro di stampa in base ai prodotti che devono essere creati nonché ai processi da 
creare per questi prodotti. JDF rappresenta un contenitore per definire un lavoro. 

Job Messaging Format (JMF) - Formato dati XML basato su JDF. È un protocollo 
che consente la comunicazione tra i componenti di un flusso di lavoro JDF. JMF 
fornisce una serie di comandi e interrogazioni come invio lavoro JDF, gestione 
code, descrizione funzionalità dispositivo e notifica eventi.

1.1.2 Scopo del documento
La Guida per l'utente del Servizio JMF è progettata per essere utilizzata come 
documento di consultazione generale in cui sono descritti gli argomenti seguenti:

• Installazione del software

• Configurazione di diversi client supportati, tra cui:

• Adobe Acrobat

• FreeFlow Web Services

• Elenco delle interrogazioni e dei comandi supportati

• Comandi CLI (interfaccia della riga di comando) supportati

Per ulteriori informazioni su come utilizzare i client supportati, fare riferimento alla 
documentazione del client.
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1.1.3 Descrizione
FreeFlow - Servizio JMF implementa la specifica JDF versione 1.2. Il livello di 
supporto è descritto nel documento FreeFlow JDF Support Specification, versione 
7.0 ed è conforme a un sottoinsieme di MIS ICS livello 2 e a un sottoinsieme di MIS 
ICS livello 3. FreeFlow - Servizio JMF è fornito su http solo per interazioni non 
protette.

FreeFlow - Servizio JMF supporta client JMF quali Adobe Acrobat 7 e 8 
Professional, nonché FreeFlow Web Services. La configurazione di questi client è 
descritta nella sezione 2.3.

FreeFlow - Servizio JMF invia i lavori direttamente alle stampanti e di conseguenza 
è considerato un dispositivo in quanto si comporta come un proxy per la 
stampante che esegue i nodi JDF.

FreeFlow - Servizio JMF fornisce il supporto seguente:

• Accetta il messaggio di comando SubmitQueueEntry 

• Accetta il messaggio Status Query con una sottoscrizione per aggiornamenti 
stato lavoro e stampante

• Invia messaggi Status Signal a uno o più abbonati in ascolto su porte diverse 
o su indirizzi IP completamente separati.

• Restituisce il file di istanza JDF modificato al client quando il lavoro viene 
completato o interrotto tramite il messaggio di comando ReturnQueueEntry.

• Accetta il messaggio di interrogazione KnownDevices 

• Accetta il messaggio di comando AbortQueueEntry 

• Accetta il messaggio di comando StopPersistentChannel

• Accetta il messaggio Status Queue Query
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1.2.0 Installazione, disinstallazione, aggiornamento e 
configurazione

In questa sezione viene descritta la procedura di installazione di FreeFlow - 
Servizio JMF.

1.2.1 Installazione
FreeFlow - Servizio JMF deve essere eseguito su un host singolo e non può 
coesistere con altre applicazioni FreeFlow ad eccezione di Print Manager e Web 
Services.

L'utente connesso deve disporre di diritti di amministratore per installare programmi 
su una piattaforma Windows. Durante la procedura di installazione verranno 
richieste le informazioni sottostanti.

• Directory principale di installazione. L'impostazione predefinita è 
"C:\Programmi\Xerox\FreeFlow - Servizio JMF".

Per installare il prodotto, seguire questi passaggi.

1. Se il programma di installazione non si avvia automaticamente, fare 
doppio clic sul file install.exe.

2. Selezionare un lingua dal menu a discesa. Fare clic su <OK>.

3. Nella schermata introduttiva, fare clic su <Avanti>. 

4. Nella schermata di installazione della licenza del software, selezionare 
l'opzione "Accetto" per accettare i termini del contratto di licenza 
dell'utente finale. Fare clic su <Avanti>.

5. Nella schermata Selezionare il tipo di installazione, selezionare 
FreeFlow - Servizio JMF e Printer Registration. Fare clic su <Avanti>.

6. Nella schermata Selezionare la cartella di installazione, accettare la 
directory di installazione predefinita oppure immettere un percorso di 
installazione alternativo. Fare clic su <Avanti>.

7. Nella schermata Selezionare la posizione dei collegamenti rapidi, 
selezionare un'opzione cartella di collegamento. Fare clic su <Avanti>.

8. Verificare le opzioni di installazione nella schermata Sommario della 
preinstallazione. Fare clic su <Installa>.

9. Fare clic su <Fatto> per completare l'installazione software e riavviare il 
sistema.

Al termine, all'interno del menu Start, "Xerox FreeFlow Software->FreeFlow - 
Servizio JMF", saranno disponibili i collegamenti sottostanti.

• Servizi

• Riga di comando

Il collegamento Servizi è usato quando si interrompe e si avvia FreeFlow - Servizio 
JMF. La riga di comando è utilizzata per richiamare i comandi CLI di FreeFlow - 
Servizio JMF.



FreeFlow - Servizio JMF Guida per l'utente

1 - 4

Se è abilitato Windows Firewall, potrebbe essere necessario configurare il firewall 
per abilitare la comunicazione con FreeFlow - Servizio JMF. Andare a 
“Configurazione delle impostazioni di Windows Firewall” a pagina 8

Se è necessario configurare la memorizzazione dei lavori, le impostazioni del 
server proxy o le impostazioni dei tentativi/ritardo ReturnQueueEntry, andare a 
“Configurazione delle impostazioni” a pagina 7.

1.2.1.1. Configurazione di gruppo e utenti
Prima di utilizzare FreeFlow - Servizio JMF, è necessario aggiungere utenti 
al gruppo "Amministratori Xerox FreeFlow - Servizio JMF" e al gruppo 
"Xerox FreeFlow Common Printer Administrators".

1.2.1.1.1 Aggiunta di utenti al gruppo Xerox FreeFlow Common 
Printer Administrators

Il gruppo FreeFlow Common Printer Administrators controlla gli utenti che 
dispongono delle autorizzazioni per aggiungere una stampante al sistema. 
Solo gli utenti membri di questo gruppo possono aggiungere o modificare 
una stampante nell'applicazione Printer Registration. 

Per configurare il gruppo di utenti, seguire questi passaggi.

1. Fare clic con il pulsante destro del mouse sull'icona Risorse del 
computer e selezionare Gestione.

2. Aprire la cartella Utenti e gruppi locali. Aprire la cartella Gruppi.

3. Selezionare "Xerox FreeFlow Common Printer Administrators."

4. Aggiungere utenti al gruppo. Se necessario, creare eventuali utenti 
specifici a cui concedere l'accesso prioritario all'applicazione.

5. Chiudere la finestra Gestione computer e connettersi come uno degli 
utenti aggiunti al gruppo.

6. Selezionare Start-> Programmi-> Software Xerox FreeFlow-> Printer 
Administration-> Printer Registration.

7. Nella finestra di dialogo Prodotti installati, verificare che la casella di 
controllo dei FreeFlow - Servizio JMF sia selezionata. Fare clic su 
<OK>.

8. Aggiungere una o più stampanti di produzione. Se necessario, fare 
riferimento alla Guida in linea dell'applicazione Printer Registration per 
le istruzioni di aggiunta di una stampante.
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1.2.1.1.2 Aggiunta di utenti al gruppo Amministratori Xerox 
FreeFlow - Servizio JMF

FreeFlow - Servizio JMF si basa sul meccanismo di protezione del sistema 
operativo per l'autenticazione. Tutti gli utenti autenticati devono disporre di 
un account sull'host che esegue FreeFlow - Servizio JMF. 

L'autorizzazione viene imposta attraverso l'interfaccia della riga di comando 
(CLI, Command Line Interface), che deve trovarsi sullo stesso host che 
esegue FreeFlow - Servizio JMF. La CLI utilizza le credenziali associate 
all'utente connesso per gli scopi di autorizzazione. È supportato solo un 
livello di accesso singolo - "Amministratori Xerox FreeFlow - Servizio JMF". 
Prima di eseguire qualsiasi comando CLI, è necessario creare questo 
gruppo e associarvi degli utenti.

Per configurare il gruppo di utenti, seguire questi passaggi.

1. Fare clic con il pulsante destro del mouse sull'icona Risorse del 
computer e selezionare Gestione.

2. Aprire la cartella Utenti e gruppi locali. Aprire la cartella Gruppi.

3. Selezionare "Amministratori Xerox FreeFlow - Servizio JMF".

4. Aggiungere utenti al gruppo. Se necessario, creare eventuali utenti 
specifici a cui concedere l'accesso prioritario all'applicazione.

5. Chiudere la finestra Gestione computer e connettersi come uno degli 
utenti aggiunti al gruppo Amministratori Xerox FreeFlow - Servizio JMF.

1.2.2 Disinstallazione
Prima di disinstallare FreeFlow - Servizio JMF, è necessario disinstallare il servizio 
di autorizzazione FreeFlow. La disinstallazione del servizio di autorizzazione 
FreeFlow viene richiesta tramite la finestra di dialogo Installazione applicazioni di 
Windows (Start->Impostazioni->Pannello di controllo). Richiamare la voce di menu 
"Installazione applicazioni".

Quando FreeFlow - Servizio JMF viene disinstallato, i file generati dopo 
l'installazione (ad esempio lavori, stampanti e dati di spooling) non vengono 
rimossi. 

La disinstallazione di FreeFlow - Servizio JMF viene richiesta tramite la finestra di 
dialogo Installazione applicazioni di Windows (Start->Impostazioni->Pannello di 
controllo). Richiamare la voce di menu "Installazione applicazioni".

È possibile anche disinstallare l'applicazione FreeFlow Printer Registration. 
La disinstallazione dello strumento viene richiesta tramite la finestra di dialogo 
Installazione applicazioni di Windows (Start->Impostazioni->Pannello di controllo). 
Richiamare la voce di menu "Installazione applicazioni".
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1.2.3 Aggiornamento
FreeFlow - Servizio JMF può essere aggiornato dalla versione 6.0 alla versione 7.0. 
Le operazioni necessarie includono prima di tutto il backup della directory 
"persistence" e la disinstallazione di Servizio JMF, del servizio di autorizzazione e di 
Printer Registration. 

Per eseguire il backup di Servizio JMF, andare al percorso di installazione della 
versione 6.0: C:\Programmi\Xerox\FreeFlow Print Manager - Servizi JMF. Copiare 
la seguente directory in un percorso di backup:

• persistence

Disinstallare Servizio JMF, il servizio di autorizzazione e Printer Registration. 
Vedere “Disinstallazione” a pagina 5 per le istruzioni.

Installare FreeFlow - Servizio JMF attenendosi a “Installazione” a pagina 3. 
Eseguire tutte le operazioni di configurazione per garantire una corretta definizione 
degli utenti e dei gruppi di utenti.

Se è necessario configurare la memorizzazione dei lavori, le impostazioni del 
server proxy o le impostazioni tentativi/ritardo di ReturnQueueEntry, e il file di 
configurazione non è ancora stato modificato, andare a “Configurazione delle 
impostazioni” a pagina 7.

1.2.4 Installazione di patch e aggiornamenti
È talvolta necessario installare patch per il software FreeFlow - Servizio JMF. 
In questa sezione vengono descritte le procedure per installare una patch.

Per installare una patch di FreeFlow - Servizio JMF, è necessario collegarsi come 
utente con privilegi amministrativi per Windows.

1. Inserire il CD della patch di FreeFlow - Servizio JMF nel PC. Il CD viene 
eseguito automaticamente.

2. Nella schermata iniziale, scegliere la lingua desiderata dal menu a 
discesa e fare clic su <OK>.

3. Nella schermata introduttiva di FreeFlow - Servizio JMF, fare clic su 
<Avanti>.

4. Nella schermata Sommario della preinstallazione, fare clic su <Installa>. 
Verrà avviata l'installazione della patch di FreeFlow - Servizio JMF.

5. Al termine dell'installazione, selezionare il pulsante di opzione <Sì, 
riavvia il sistema>.

6. Fare clic su <Fatto>. Il sistema verrà riavviato.
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1.2.5 Configurazione delle impostazioni
FreeFlow - Servizio JMF contiene impostazioni che è possibile cambiare 
modificando un file di configurazione. Esistono anche dei passaggi richiesti per 
consentire la comunicazione attraverso il Windows Firewall.

1.2.5.1. Modifica dell'impostazione di memorizzazione dei lavori
Il Servizio JMF memorizza in genere i lavori completati e interrotti per un 
giorno. Questo periodo di memorizzazione può essere cambiato 
modificando il file "Jdfjmfgateway.properties". Effettuare quanto segue:

1. Aprire un editor di testo sul sistema (ad esempio, Blocco note).

2. Aprire il file “Jdfjmfgateway.properties” nell'editor di testo. Il file si trova 
nella directory C:\Programmi\Xerox\FreeFlow Print Manager - Servizi 
JMF\config.

3. Individuare la voce "RETENTION_PERIOD=86400" nel file. Modificare 
l'impostazione nel periodo di memorizzazione desiderato. Il valore 
numerico è il numero totale di secondi di memorizzazione dei lavori.

4. Salvare e chiudere il file.

1.2.5.2. Impostazioni del server proxy
Se è richiesto un server proxy per recuperare i file utilizzando il file http a cui 
fa riferimento il Servizio JMF, è necessario configurare le relative 
impostazioni.

1. Aprire un editor di testo sul sistema (ad esempio, Blocco note).

2. Aprire il file “Jdfjmfgateway.properties” nell'editor di testo. Il file si trova 
nella directory C:\Programmi\Xerox\FreeFlow Print Manager - Servizi 
JMF\config.

3. Individuare la voce "proxyHost=" nel file. Immettere l'indirizzo IP o il 
nome server per l'host proxy dopo il segno di uguale.

4. Individuare la voce "proxyPort=" nel file. Immettere il numero porta per 
l'host proxy dopo il segno di uguale.

5. Salvare e chiudere il file.

1.2.5.3. Impostazioni numeri di tentativi/ritardo del segnale 
SendStatus

Se è necessario modificare il numero di tentativi o il ritardo tra i tentativi per 
il segnale ReturnQueueEntry, configurare le impostazioni seguenti.

1. Aprire un editor di testo sul sistema (ad esempio, Blocco note).

2. Aprire il file “Jdfjmfgateway.properties” nell'editor di testo. Il file si trova 
nella directory C:\Programmi\Xerox\FreeFlow Print Manager - Servizio 
JMF\config.

3. Individuare la voce  "RQERetries =". Immettere un valore per il numero 
di tentativi dopo il segno di uguale.
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4. Individuare la voce  "RQERetryDelay =". Immettere un numero di 
secondi per il ritardo tra ogni tentativo dopo il segno di uguale.

5. Salvare e chiudere il file.

1.2.5.4. Configurazione delle impostazioni di Windows Firewall
Se il FreeFlow - Servizio JMF è installato su un PC in cui è abilitato Windows 
Firewall, è necessario configurare Windows Firewall per consentire la 
comunicazione con la porta di FreeFlow - Servizio JMF.

Per configurare le impostazioni di Firewall, seguire questi passaggi.

1. Aprire il pannello di controllo e fare doppio clic sull'applet Centro 
sicurezza PC (in base alla versione del sistema operativo, la applet 
potrebbe chiamarsi "Firewall").

2. Selezionare il collegamento Windows Firewall (il collegamento potrebbe 
chiamarsi "Consenti programma con Windows Firewall").

3. Selezionare la scheda Eccezioni.

4. Selezionare il pulsante <Aggiungi porta>.

5. Nel campo Nome, digitare "FreeFlow - Servizio JMF".

6. Nel campo Numero porta, digitare "7781".

7. Selezionare <OK> per chiudere la finestra di dialogo Aggiungi porta. 
Fare clic su <OK> per chiudere la finestra di dialogo delle impostazioni 
di Firewall.
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1.2.6 Configurazione dei client
Nelle sezioni successive viene descritto come configurare le applicazioni client del 
Servizio JMF supportate. Eseguire solo le procedure sottostanti per i client che 
verranno utilizzati per accedere a FreeFlow - Servizio JMF. FreeFlow - Servizio 
JMF può essere usato contemporaneamente con più client. 

1.2.6.1. Configurazione di Adobe Acrobat 7 e 8
Per configurare Adobe Acrobat per l'invio di lavori JDF a FreeFlow - 
Servizio JMF, configurare la stampante in Acrobat seguendo questi 
passaggi.

1. Visualizzare lo strumento JDF Job Definitions (Definizioni lavoro JDF) 
nella finestra Adobe Acrobat Professional:

• Per Acrobat 7: Tools->Print Production->JDF Job Definitions 
(Strumenti: Stampante di produzione: Definizioni lavoro JDF)

• Per Acrobat 8: Advanced->Print Production->JDF Job Definitions 
(Avanzate: Stampante di produzione: Definizioni lavoro JDF)

2. Selezionare "Submission Manager" (Gestione invio)

3. Selezionare "Add" (Aggiungi). Viene visualizzata la finestra di dialogo 
"Submission Setup" (Impostazione invio).

4. Nelle opzioni di invio, selezionare "Convert to a MIME package and 
submit to a JMF device" (Converti in pacchetto MIME e invia a periferica 
JMF)

5. Immettere l'indirizzo URL come http://<indirizzo IP o nome host di 
FreeFlow Print Manager - Servizi JMF>:7781/[id dispositivo]

NOTA: Se l'indirizzo di rete di FreeFlow - Servizio JMF supporta il formato 
IPv4 e/o IPv6, quando si inserisce l'URL l'indirizzo IP deve essere nel 
formato IPv4. Adobe Acrobat versione 7 e 8 non supportano indirizzi in 
lettere IPv6.

NOTA: Il valore [id dispositivo] corrisponde al nome stampante specificato 
nell'utilità Printer Registration per la stampante a cui si accede dal Servizio 
JMF.

1.2.6.2. Configurazione di FreeFlow Web Services 
NOTA: Dopo l'installazione di Web Services e Servizio JMF ci saranno due 
istanze di Printer Registration, una da Web Services e una da Servizio 
JMF. In base al prodotto che è stato installato per primo, l'instanza 
installata per seconda dovrà fare riferimento all'altra per assicurare un 
corretto funzionamento dell'integrazione. 

Per configurare FreeFlow Web Services per l'invio di lavori a FreeFlow - 
Servizio JMF, seguire questi passaggi.

1. Accedere a Web Services come fornitore stampa.

2. Selezionare la scheda [Impostazioni].

3. Selezionare la scheda [Dispositivi di uscita].



FreeFlow - Servizio JMF Guida per l'utente

1 - 10

4. Fare clic sul pulsante [Aggiungi] per aggiungere un nuovo dispositivo.

5. Nella finestra di dialogo [Aggiungi dispositivo], immettere il nome del 
dispositivo.

6. Selezionare [Digitale] per il gruppo Dispositivo.

7. Selezionare [FreeFlow - Servizio JMF] per il tipo di macchina e fare clic 
sul pulsante [OK].

8. Dai dispositivi di uscita elencati sul lato sinistro, selezionare il dispositivo 
creato al punto 7.

9. Dopo aver scelto il dispositivo, selezionare la scheda [Canali output] sul 
lato destro.

10. Impostare la porta su 7781.

11. Selezionare [JdfIntent_ws6] per Produci output JDF.

12. Impostare l'indirizzo IP al percorso sul PC di FreeFlow - Servizio JMF e 
fare clic sul pulsante [OK]. Verrà visualizzato un messaggio per 
confermare che le modifiche sono state salvate.

NOTA: Se l'indirizzo di rete di FreeFlow - Servizio JMF supporta il formato 
IPv4 e/o IPv6, quando si inserisce URL l'indirizzo IP deve essere nel 
formato IPv4. FreeFlow Web Services non supporta indirizzi in lettere 
IPv6.

13. Fare clic sul collegamento [Il dispositivo è compatibile con il sistema 
multicoda]. Fare clic su [Stampanti disponibili] per visualizzare l'elenco 
delle stampanti che è possibile utilizzare in FreeFlow - Servizio JMF. 
Selezionare una stampante, quindi fare clic su <Salva> per salvare la 
configurazione.

È ora possibile inviare i lavori al dispositivo e alla coda configurati in 
precedenza.

L'operazione di invio lavori da FreeFlow Web Services comprende due 
passaggi:

1. Accedere come acquirente e ordinare il lavoro da inviare a FreeFlow - 
Servizio JMF.

2. Accedere come fornitore stampa e approvare il lavoro da inviare a 
FreeFlow - Servizio JMF.

Per informazioni su come eseguire queste operazioni, vedere la 
documentazione FreeFlow Web Services.
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1.2.7 Aggiunta e configurazione di stampanti
Il Servizio JMF non mantiene un elenco delle stampanti di produzione configurate. 
Per aggiungere e configurare le stampanti, è necessario utilizzare l'applicazione 
FreeFlow Printer Registration. Dopo aver aggiunto le stampanti di produzione 
necessarie, occorre visualizzare un prompt dei comandi e utilizzare i comandi CLI 
di FreeFlow - Servizio JMF sottostanti per registrare le stampanti in FreeFlow - 
Servizio JMF. 

• Richiamare il comando xomupddev CLI per recuperare l'elenco delle 
stampanti aggiornate dall'applicazione Printer Registration. 

Per informazioni su come utilizzare l'applicazione FreeFlow Printer Registration, 
vedere la Guida in linea dell'applicazione.

1.2.8 Arresto e riavvio
Per arrestare FreeFlow - Servizio JMF: 

• Utilizzando Servizi Windows, selezionare il servizio denominato "FreeFlow - 
Servizio JMF" e richiamare l'interruzione del comando. Per richiamare la 
finestra Servizi Windows, selezionare "Start->Tutti i programmi->Xerox 
FreeFlow Software->FreeFlow - Servizio JMF->Servizi".

• In alternativa, è possibile interrompere FreeFlow - Servizio JMF digitando il 
comando "xomshutd" in una finestra del prompt dei comandi. Per richiamare 
la finestra del prompt dei comandi, selezionare "Start->Tutti i programmi-
>Xerox FreeFlow Software->FreeFlow - Servizio JMF->CommandLine".

Per riavviare FreeFlow - Servizio JMF: 

• Utilizzando Servizi Windows, selezionare il servizio denominato "FreeFlow - 
Servizio JMF" e richiamare l'avvio del comando. Per richiamare la finestra 
Servizi Windows, selezionare "Start->Tutti i programmi->Xerox FreeFlow 
Software->FreeFlow - Servizio JMF->Servizi".
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1.3.0 Interrogazioni e comandi JMF supportati

1.3.1 SubmitQueueEntry
Il messaggio SubmitQueueEntry consente di inviare un lavoro JDF a una 
stampante. FreeFlow - Servizio JMF non esegue la convalida di JDF rispetto alle 
funzionalità della stampante. Se il JDF contiene attributi non accettabili per la 
stampante, la macchina tenterà comunque di stampare il lavoro. Se il lavoro risulta 
impossibile da stampare, questo verrà interrotto e un segnale JMF verrà inviato al 
MIS.

Sono accettati i tipi di nodi seguenti:

• Stampa digitale combinata

• Scopo prodotto - descrive l'intenzione del cliente per il prodotto finale. 
FreeFlow - Servizio JMF è in grado di gestire gli Scopi prodotto che possono 
essere stampati su una stampante digitale. 

L'ID dispositivo richiesto per la stampa viene identificato nell'URL di FreeFlow - 
Servizio JMF (http://<host>:7781/[ID dispositivo]) o in ID dispositivo dell'invio JDF. 
Se sono specificati entrambi, il secondo ha la priorità. Se l'ID dispositivo non è 
valido, il dispositivo non accetta lavori o è impossibile stabilire la connessione con il 
dispositivo, la richiesta verrà rifiutata restituendo un codice di errore.

Se l'invio contiene un nodo Scopo prodotto, FreeFlow - Servizio JMF lo convertirà 
in un nodo Stampa digitale combinata. Gli eventuali scopi prestampa o poststampa 
presenti verranno ignorati.

È consentito inviare un unico file PDL per lavoro JDF. Se la programmazione lavoro 
è composta da diversi componenti, questi devono fare tutti riferimento allo stesso 
file PDL.

Il file di istanza JDF può contenere un file di riferimento. I riferimenti file supportati 
sono:

file://host/percorso

dove host è il nome di dominio completo del sistema in cui si trova il file a cui si fa 
riferimento. L'host può contenere la stringa "localhost" oppure essere vuoto. Il 
percorso è quello della directory a cui si fa riferimento.

cid:id-contenuto

id-contenuto identifica un file inviato all'interno del messaggio MIME a più parti.

http://host:porta/percorso

dove host è il nome di dominio completo del sistema in cui si trova il file a cui si fa 
riferimento. L'host può contenere la stringa "localhost" oppure essere vuoto. Porta 
contiene il numero porta del server http. Il percorso è quello della directory a cui si 
fa riferimento.

Se il lavoro, per una ragione qualsiasi, non può essere stampato dopo che l'invio è 
stato accettato, il lavoro verrà interrotto e un segnale JMF verrà inviato al MIS.
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1.3.2 Canali persistenti
FreeFlow - Servizio JMF invia messaggi Status Signal al MIS tramite un canale 
persistente. Il MIS imposta un canale persistente inviando un messaggio Status 
Query con un elemento Subscription. La sottoscrizione identifica un URL che verrà 
registrato per il controller. Dopo aver stabilito il canale persistente, questo rimane 
aperto (anche dopo i riavvii del sistema) finché non viene ricevuto un messaggio 
StopPersistentChannel.

Il messaggio StopPersistentChannel annulla la registrazione di un controller in 
ascolto da un canale persistente. Dopo aver inviato il comando, non sarà possibile 
inviare altri messaggi al controller. 

1.3.3 Segnali di stato
FreeFlow - Servizio JMF invia un messaggio Status Signal JMF agli abbonati per 
ciascuna delle condizioni sottostanti.

• Lavoro inoltrato alla stampante

• Lavoro trattenuto alla stampante in attesa delle risorse (supporto, finitura)

• Stampa del lavoro in corso

• Stampa del lavoro interrotto in attesa delle risorse (supporto, finitura)

• Connessione stampante persa

• Lavoro completato

• Lavoro interrotto

1.3.4 ReturnQueueEntry
Il comando ReturnQueueEntry consente di restituire un lavoro inviato con un 
comando SubmitQueueEntry. Questo comando viene inviato da FreeFlow - 
Servizio JMF dopo il completamento o l'interruzione del lavoro. Le opzioni Audits e 
JDF/@Status del JDF in corso di elaborazione verranno impostate su "Completed" 
(Completato) e il JDF verrà inviato all'URL come specificato da SubmitQueueEntry/
@ReturnJMF.

Il Servizio JMF tenterà di inviare più volte un comando ReturnQueueEntry, fino a 
che questo non viene ricevuto dal client. Questo fornisce a un client 
temporaneamente inattivo il tempo di riprendere a funzionare. I tentativi di invio 
verranno inoltre eseguiti in periodi di tempo preconfigurati, nell'ipotesi che il 
ripristino della corretta funzionalità possa richiedere del tempo (ad esempio, 
durante un riavvio). Il periodo di tempo e il numero di tentativi sono entrambi 
configurabili. Vedere “Impostazioni numeri di tentativi/ritardo del segnale 
SendStatus” a pagina 7

1.3.5 KnownDevices
L'interrogazione KnownDevices richiede informazioni sui dispositivi. Per ciascun 
dispositivo viene restituito lo stato e l'ID.
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1.3.6 AbortQueueEntry 
Se non è stato inoltrato alla stampante, il lavoro verrà cancellato e nella risposta 
verrà restituito lo stato Success (Riuscito). Se il lavoro è già stato inoltrato alla 
stampante e la stampa non è terminata, nella risposta verrà restituito lo stato 
Success (Riuscito) e la richiesta Abort (Interrompi) verrà inoltrata alla stampante. 

Se l'invio lavoro originale contiene un comando returnJMF (SubmitQueueEntry/
@ReturnJMF), il JDF aggiornato verrà recapitato al percorso specificato.

1.3.7 SuspendQueueEntry 
Se non è stato inoltrato alla stampante, il lavoro verrà trattenuto e nella risposta 
verrà restituito lo stato Success (Riuscito). Se il lavoro è già stato inoltrato alla 
stampante, nella risposta verrà restituito un codice di errore.

1.3.8 ResumeQueueEntry 
Se non è stato inoltrato alla stampante, il lavoro verrà rilasciato per la stampa e 
nella risposta verrà restituito lo stato Success (Riuscito). Se il lavoro è già stato 
inoltrato alla stampante, nella risposta verrà restituito un codice di errore. 

1.3.9 Interrogazione sullo stato
Il controller può ricevere la richiesta di inviare un elenco di tutti i lavori nella coda, 
insieme allo stato e agli attributi associati. Le informazioni relative a un particolare 
lavoro possono essere restituite se nella query è specificato QueueEntryID/ID 
lavoro.

1.3.10 Interrogazione alla coda sullo stato
Il controller può ricevere la richiesta di inviare un elenco di tutti i lavori nella coda 
filtrati in base allo stato, insieme allo stato e agli attributi associati. Il filtro è 
specificato nell'interrogazione. Se non esistono lavori il cui stato corrisponde al filtro 
specificato, l'elenco dei lavori sarà vuoto. Se il filtro è nullo, verrà restituito un 
elenco dei lavori insieme allo stato e agli attributi associati.
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1.4.0 Comandi CLI supportati

1.4.1 update-devices
Questo comando consente di unire le stampanti registrate nello strumento 
FreeFlow Printer Registration e le stampanti usate da FreeFlow - Servizio JMF. 
Il risultato è un elenco di stampanti gestite da FreeFlow - Servizio JMF in base alle 
stampanti registrate nello strumento FreeFlow Printer Registration. Le stampanti 
aggiunte utilizzando lo strumento FreeFlow Printer Registration vengono registrate 
in FreeFlow - Servizio JMF. Le stampanti eliminate utilizzando lo strumento 
FreeFlow Printer Registration vengono eliminate da FreeFlow - Servizio JMF se 
non sono presenti lavori incompleti.

Se una stampante viene rimossa dallo strumento FreeFlow Printer Registration e il 
comando xomupddev viene richiamato durante l'inoltro di lavori non completati alla 
stampante "cancellata", questa continuerà ad essere visualizzata in FreeFlow - 
Servizio JMF fino a quando non esistono più lavori incompleti.

Nome comando:

xomupddev

Operando:

nessuno

Restituisce:

0 se riuscito

Esempio:

xomupddev

1.4.2 shutdown-system
Questo comando arresta immediatamente FreeFlow - Servizio JMF.

Nome comando:

xomshutd

Operando:

nessuno

Restituisce:

0 se riuscito

Esempio:

xomshutd
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1.4.3 list-devices
Questo comando restituisce un elenco di dispositivi registrati nel sistema.

Nome comando:

xomlisdev

Operando:

nessuno

Opzioni:

nessuna

Restituisce:

0 se riuscito

Esempio:

xomlisdev
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1.5.0 Risoluzione dei problemi
In questa sezione viene descritta la procedura di risoluzione di diversi problemi di 
FreeFlow - Servizio JMF.

1.5.1 Abilita registrazione
È possibile configurare il sistema affinché registri gli errori in base a un livello 
definito dall'utente. Ad esempio, l'impostazione dell'attributo di sistema su SEVERE 
consente la registrazione dei soli errori gravi. L'impostando l'attributo su FINEST 
verranno registrati tutti i tipi di dati di registro, anche i più semplici.

Sono disponibili i seguenti attributi di registrazione:

• SEVERE

• WARNING

• INFO

• CONFIG

• FINE

• FINER

• FINEST

Per abilitare la registrazione, procedere in questo modo:

1. Aprire un editor di testo sul sistema (ad esempio, Blocco note).

2. Aprire il file “Jdfjmfgateway.properties” nell'editor di testo. Il file si trova 
nella directory C:\Programmi\Xerox\FreeFlow Print Manager - Servizio 
JMF\config.

3. Individuare la voce "com.xerox.gateways.jdfjmf.level" nel file. 

4. Aggiungere l'attributo di registrazione dopo la voce e il segno di uguale. 
Ad esempio, "com.xerox.gateways.jdfjmf.level=FINEST".

5. Individuare la voce "JMFDEBUG" e Modificare il valore da "false" a 
"true".

6. Salvare e chiudere il file.

Per rendere effettive le modifiche è necessario riavviare FreeFlow - Servizio JMF.

I file di registro verranno salvati nei percorsi di directory seguenti:

• C:\Programmi\Xerox\FreeFlow Print Manager - Servizi JMF\logs

• C:\Programmi\Xerox\FreeFlow Print Manager - Servizi JMF\temp
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1.5.2 Connessione stampante
Se il Servizio JMF restituisce un codice di errore 2, verificare la connessione alla 
stampante. Immettere il comando seguente:

xomgetdev –x printer-state <nome stampante>

Se il comando restituisce il valore "printer-state=Unknown", il server JMF non è in 
grado di comunicare con la stampante. Di seguito sono descritte le azioni da 
eseguire per risolvere il problema:

• Verificare che i dati della stampante (ad esempio, indirizzo di rete) immessi in 
Printer Registration Tool siano corretti.

• Verificare la comunicazione tra la stampante e il Servizio JMF eseguendo, ad 
esempio, un test di ping.

• Verificare che la stampante sia funzionante.
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1.6.0 Limitazioni
In questa sezione vengono descritte le limitazioni di cui l'utente deve essere 
consapevole quando utilizza FreeFlow - Servizio JMF.

1.6.1 Creazione di programmazioni lavoro JDF in Adobe Acrobat 
Professional

Quando si crea una programmazione lavoro JDF in Adobe Acrobat Professional da 
inviare a FreeFlow Process Manager, è necessario specificare il numero di pagine 
nel documento o le pagine nell'intervallo per consentire la gestione corretta della 
programmazione.

Per specificare il numero di pagine, procedere come descritto di seguito:

1. Selezionare Start->Programmi->Adobe Acrobat Professional.

2. In Adobe Acrobat Professional, selezionare Advanced->Print 
Production->JDF Job Definitions (Avanzate: Stampante di produzione: 
Definizioni lavoro JDF).

3. Selezionare <New> (Nuova).

4. Nella finestra di dialogo Create New Job Definition (Crea nuova 
definizione processo), individuare l'opzione desiderata e selezionare 
<Save> (Salva). Il percorso file viene visualizzato nella casella di testo 
Filename (Nome file).

5. Selezionare <Create and Edit> (Crea e modifica).

6. Nella finestra di dialogo Edit JDF Job Definitions (Modifica definizione 
processo JDF), selezionare <Add Section> (Aggiungi sezione).

7. Nella sezione "Number of Pages" (Numero di pagine), immettere il 
valore appropriato.

8. Selezionare <OK>.

9. Selezionare <Close> (Chiudi).

10. Uscire da Adobe Acrobat Professional.

Per specificare un intervallo di pagine, procedere come descritto di seguito:

1. Selezionare Start->Programmi->Adobe Acrobat Professional.

2. In Adobe Acrobat Professional, selezionare Advanced->Print 
Production->JDF Job Definitions (Avanzate: Stampante di produzione: 
Definizioni lavoro JDF).

3. Selezionare <New> (Nuova).

4. Nella finestra di dialogo Create New Job Definition (Crea nuova 
definizione processo), individuare l'opzione desiderata e selezionare 
<Save> (Salva). Il percorso file viene visualizzato nella casella di testo 
Filename (Nome file).

5. Selezionare <Create and Edit> (Crea e modifica).
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6. Nella finestra di dialogo Edit JDF Job Definitions (Modifica definizione 
processo JDF), selezionare <Add Section> (Aggiungi sezione).

7. Selezionare <Add File> (Aggiungi file).

8. Nella sezione relativa alle pagine del documento da utilizzare, 
selezionare il pulsante di opzione <Pages in Range> (Intervallo di 
pagine).

9. Immettere i valori appropriati per l'intervallo pagine nelle caselle di testo.

10. Selezionare <OK>.

11. Selezionare <Close> (Chiudi).

12. Uscire da Adobe Acrobat Professional.
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2.1.0 Informazioni supplementari su Web Services
Lo scopo di questo capitolo è quello di fornire importanti informazioni supplementari 
applicabili a FreeFlow - Servizio JMF e ai segnali di stato JMF supportati se 
utilizzati in combinazione con FreeFlow Web Services.

2.1.1 FreeFlow Web Services e Xerox Production Printing Services
FreeFlow Web Services è integrato nella tecnologia di stampa di produzione Xerox 
per consentire al fornitore stampa di utilizzare programmazioni lavoro di produzione 
e di selezionare front-end digitali (DFE) FreeFlow per le stampanti di produzione 
Xerox. In Web Services, sono disponibili diversi metodi per la comunicazione con le 
stampanti di produzione Xerox o altri moduli FreeFlow. Alcuni di questi metodi 
utilizzano un nuovo standard emergente chiamato JDF (Job Definition Format) e un 
protocollo chiamato JMF (Job Messaging Format). Poiché non tutte le stampanti di 
produzione Xerox sono dotate del supporto nativo di JDF/JMF, è possibile utilizzare 
un altro modulo FreeFlow, come Servizio JMF, per inviare i lavori da Web Services 
alla stampante.

Quando si utilizza JDF/JMF, viene creato un dispositivo di uscita Web Services per 
indirizzare il lavoro a FreeFlow - Servizio JMF. Il routing effettivo del lavoro viene in 
genere assegnato come parte della configurazione di costo di un modello o tipo di 
lavoro. 

Poiché JDF è un nuovo standard, non tutti gli attributi delle programmazioni lavoro 
di Web Services sono attualmente supportati dal percorso JDF. Al momento, il 
supporto è assicurato per la selezione del supporto e il numero di copie. FreeFlow - 
Servizio JMF non esegue la convalida del JDF rispetto alle funzionalità della 
stampante; se JDF contiene attributi che la stampante non è in grado di rispettare, 
la stampante tenterà comunque di stampare il lavoro. Se il lavoro risulta impossibile 
da stampare, questo verrà interrotto e un segnale di stato JMF verrà inviato a Web 
Services. 

Con il graduale perfezionamento di questa tecnologia, si prevede un aumento del 
numero di attributi JDF supportati.

2.1.2 Segnali di stato JMF supportati
FreeFlow - Servizio JMF comunica informazioni a FreeFlow Web Services relative 
al front-end digitale (DFE, Digital Front End), ad esempio eventi (avvio, arresto, 
errore), stato (disponibile, offline e così via), risultati (conteggio e così via.) e altri 
dettagli. Lo stato del lavoro e della stampante viene ottenuto tramite il polling da 
FreeFlow - Servizio JMF al DFE e comunicato a Web Services tramite messaggi 
asincroni.

FreeFlow - Servizio JMF invia un segnale di stato JMF a Web Services per 
ciascuna delle condizioni sottostanti.

• Inoltro del lavoro alla stampante

• Lavoro trattenuto alla stampante in attesa delle risorse (supporto, finitura)*

• Stampa del lavoro in corso

• Stampa del lavoro interrotta in attesa delle risorse (supporto, finitura)*
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• Connessione stampante persa

• Lavoro completato

• Lavoro interrotto

* Condizioni di errore che potrebbero richiedere l'intervento dell'operatore

NOTA: non tutti i segnali di stato JMF sono visualizzati agli utenti finali nella coda 
Dispositivo di stampa di Web Services.

La tabella nella pagina seguente descrive i segnali di stato JMF ricevuti da Web 
Services, con i messaggi corrispondenti visualizzati nella coda Dispositivo di 
stampa (se disponibili). Questi messaggi sono visibili posizionando il cursore 
sull'icona nella colonna "Stato" della coda Dispositivo di stampa di Web Services 
(fare riferimento all'illustrazione, “Coda Dispositivo di stampa di FreeFlow Web 
Services” a pagina 3).
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Coda Dispositivo di stampa di FreeFlow Web Services

Segnale di stato 
JMF Descrizione segnale Dispositivo di stampa di 

Web Services
Icona di 
stato

JobPhase/
@Status=Waiting

Lavoro inoltrato alla 
stampante

In attesa della stampa

JobPhase/
@Status=InProgress

Stampa del lavoro in 
corso

Stampa in corso

JobPhase/
@Status=Completed

Lavoro completato Stampa completata

JobPhase/
@Status=Aborted

Lavoro annullato Stampa interrotta

N/D In attesa di essere inviato alla 
stampante

N/D Inviato per la stampa

N/D File inviato completato

N/D Problema
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